QUALITY INDICATORS

Final Report

for
Administration Department
University of Michigan Medical Center

by
Management Systems Department

Total Quality Management Team:
Peter Giordano
Patrick Herzog
Christina Tatting

December 17, 1992
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executive Summary</td>
<td>2</td>
</tr>
<tr>
<td>Quality Indicator Development</td>
<td>2</td>
</tr>
<tr>
<td>Reporting Mechanism</td>
<td>2</td>
</tr>
<tr>
<td>Introduction and Background</td>
<td>3</td>
</tr>
<tr>
<td>Initial Situation</td>
<td>3</td>
</tr>
<tr>
<td>Approach and Methodology</td>
<td>4</td>
</tr>
<tr>
<td>Findings and Conclusions</td>
<td>8</td>
</tr>
<tr>
<td>Quality Indicator Development</td>
<td>8</td>
</tr>
<tr>
<td>Reporting Mechanism</td>
<td>9</td>
</tr>
<tr>
<td>Method 1 (Decentralized)</td>
<td>9</td>
</tr>
<tr>
<td>Method 2 (Centralized)</td>
<td>9</td>
</tr>
<tr>
<td>Method 3 (Combination Centralized/Decentralized)</td>
<td>9</td>
</tr>
<tr>
<td>Recommendations</td>
<td>10</td>
</tr>
<tr>
<td>Quality Indicator Development</td>
<td>10</td>
</tr>
<tr>
<td>Reporting Mechanism</td>
<td>10</td>
</tr>
<tr>
<td>Banyan File Servers</td>
<td>11</td>
</tr>
<tr>
<td>Shared File Implementation</td>
<td>11</td>
</tr>
<tr>
<td>Limitations of the Banyan Network</td>
<td>12</td>
</tr>
<tr>
<td>Action Plan</td>
<td>12</td>
</tr>
<tr>
<td>Quality Indicator Development</td>
<td>12</td>
</tr>
<tr>
<td>Reporting Mechanism</td>
<td>13</td>
</tr>
</tbody>
</table>
Executive Summary

Quality Indicator Development

Approximately 150 quality indicators have been submitted by 75 departments throughout the hospital. Although not all departments have sent in the descriptions of their indicators or data representing current performance, the structure is now in place to record that information when it is available. A notebook is available for collecting tabular and graphical quality data from each department. Also, an evaluation structure is set up which evaluates current indicators based on meeting the criteria for good indicators and monitoring the data. This structure is also useful for determining which departments have or have not submitted their descriptions and/or data for two quality indicators.

In order to continue with this quality improvement effort, it is necessary to establish good communication lines to the departments. We have recommended that a person within the hospital be placed in charge of continuing to update the current information and follow-up with the departments, to ensure that they understand the requirements of reporting quality data and how to monitor it.

Not only is it important to maintain communication with the departments regarding this effort, but it is also necessary to have strong support from management. At the current level of support, this project may not have enough strength to continue. The departments must see the importance of monitoring quality indicators through examples set by management.

Based on our recommendations, we propose that the following steps be taken in order to continue the project to monitor quality indicators:

- Continue requesting data from the departments and updating the appropriate information in the notebook and evaluation structure.

- Communicate to the departments:
  - The importance of establishing quality indicators.
  - The requirement that each department submit the descriptions of two quality indicators, along with monthly data in both tabular and graphical form.
  - The evaluations for the current indicators.
  - The availability of example reporting formats.
  - The support by upper management.

- Prepare monthly reports indicating which departments have or have not submitted quality indicators.

Reporting Mechanism

In researching possible ways to store and retrieve all quality indicator data for current and future use, we have proposed that the data be placed on a shared file on a server on the Banyan network system. This allows each department to be responsible for tracking and graphing its own data, and allows management to easily review all of the tabular information in a central location.
It is necessary to construct consistent tabular and graphical displays of data so that management can easily interpret the information from each department. Our recommendation allows each department to format their data to create consistent, yet tailored, reports. By following the examples of tabular and graphical displays of data, the departments will be able to generate consistent reports that can be easily reviewed by management.

**Introduction and Background**

Total Quality Management is one of the most important changes in health care management today. With this in mind, a significant goal for the University of Michigan Medical Center (UMMC) is to establish a continuous monitoring system for the departments to report and monitor quality indicators. Currently, quality indicators have not been established in all departments, and there is no system in place for tracking performance.

As a step toward achieving continuous quality improvement, we have proposed to develop a framework for the departments at the UMMC to consistently report and track their progress based on new customer focused quality indicators. This Quality Indicators project focused on gathering and evaluating quality indicators submitted by the departments and providing a reporting mechanism for monitoring their performance.

The goal of the Quality Indicators team is to set in motion a reporting and monitoring process that can be maintained in the future. By establishing the initial framework, little effort will be required to add more indicators and data at a later time.

The scope of the project was to collect and evaluate the available indicators, and explore the possibilities of presenting data in both tabular and graphical form. We also investigated the development of an automated system for future use.

**Initial Situation**

At the onset of the project, in September 1992, 129 quality indicators had been submitted from 70 departments, and only a few were being tracked. However, not all of the indicators were clearly defined, and their graphical formats were inconsistent. In addition, there were many departments which had not developed indicators. One of our first goals was to coordinate this information and establish a formal structure by which departments could define and communicate their indicators.

Another main consideration involved developing and implementing a tracking mechanism for departmental quality indicators. In particular, we explored the method for storage and retrieval of information in tabular and graphical forms.

A tabular form of the information is required so that individual departments may easily add and store the historical quality indicator data. This tabular form of data should be made into a standard form so that there is consistency in reporting across departments. A standard tabular form would also allow consistent construction of graphical displays of the data.
A graphical form of the information is required so it is easier to track trends in quality indicator measurements over time. Graphical display of time related data easily depicts out of control or outlying points.

The project team researched three methods for storage and retrieval of the quality indicator measurement data. The three methods are listed below:

1) Decentralized Reporting

Each department enters its own data in tabular form into a spreadsheet package on Macintosh or DOS compatible personal computers. A macro within the spreadsheet package generates a graphical display of the data. These reports would then be sent to a central location to be collected and ordered into a notebook. This information would be used to assess and communicate progress as measured by the quality indicators.

2) Centralized Reporting

The data are entered into the mainframe at the hospital, and mainframe applications are used to process and display the information in tabular and graphical form. The departments would submit their data, then a central location would perform all of the tasks of entering and reporting data.

3) Combination Reporting

Following guidelines and examples of tabular and graphical reporting forms, the departments may use their own means (software packages) to create consistent tabular and graphical displays of the data. Banyan (the Local Area Network within the Hospital) or the mainframe could also be used to make a tabular form of the data available for storage and for use by the appropriate people.

Approach and Methodology

Diagram 1. illustrates the general approach followed to obtain the project goals. The key steps completed are described below.

1) Obtain Department List

The initial list of departments was organized around eleven major departments, based on the accounting structure at the hospitals. See Table 1. for the departments and their current directors. Then each major department director was asked to indicate which departments are expected and should be required to submit new customer focused quality indicators. We have updated the list for all major departments with the exception of Ambulatory Care and Professional Services (Professional Services has indicated that they will submit the list in January 1993).
Diagram 1. Approach

Table 1. Major Departments and Directors

<table>
<thead>
<tr>
<th>Department</th>
<th>Director</th>
</tr>
</thead>
<tbody>
<tr>
<td>Professional Services</td>
<td>John Gialanella</td>
</tr>
<tr>
<td>Inpatient Operations and Diagnostic</td>
<td>Larry Warren</td>
</tr>
<tr>
<td>Treatment Services</td>
<td></td>
</tr>
<tr>
<td>Finance</td>
<td>David N. Southwell</td>
</tr>
<tr>
<td>Nursing</td>
<td>Beverly Jones</td>
</tr>
<tr>
<td>Information Services Division</td>
<td>Paul R. Vegoda</td>
</tr>
<tr>
<td>Senior Associate Director</td>
<td>Ellen Gaucher</td>
</tr>
<tr>
<td>Ambulatory Care</td>
<td>Patricia Warner</td>
</tr>
<tr>
<td>Executive Director</td>
<td>John Forsyth</td>
</tr>
<tr>
<td>Chief of Clinical Affairs</td>
<td>Robert P. Kelch</td>
</tr>
<tr>
<td>Attorney's Office</td>
<td>Edward B. Goldman</td>
</tr>
<tr>
<td>Department of Human Resources</td>
<td>Laurita Thomas</td>
</tr>
<tr>
<td>Office of Planning and Marketing</td>
<td>Kenneth G. Trester</td>
</tr>
</tbody>
</table>
2) Request Quality Indicators from Departments

The quality indicators which were available at the start of the project had been submitted a year earlier, in September 1991. In order to re-initiate the quality indicator collection, our client communicated with the departments through memos and our team communicated by telephone with the departments, requesting that they submit or update their indicators. Our team also requested that the departments send in any current data they have available, or if they had none, were currently monitoring them.

As the information throughout the project was returned to our client's office, the team continued to update the final list of quality indicators. We also found that some of the indicators from the original forms were not included on the initial log of quality indicators. We added the appropriate indicators to the log of indicators.

3) Develop Criteria for Evaluating Quality Indicators

As seen in Table 2, seven criteria were developed and defined for evaluating the usefulness and appropriateness of the indicators. This list was sent by memo to each department so that they could better understand the evaluation process and use it as a guideline for updating their indicators. Included with this memo was a copy of the most recent list of indicators that had been submitted.

<table>
<thead>
<tr>
<th>Table 2</th>
<th>CRITERIA for QUALITY INDICATORS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Customer Focused</td>
<td></td>
</tr>
<tr>
<td>The indicator should relate to a service that focuses on the customer of the department.</td>
<td></td>
</tr>
<tr>
<td>2. Positive</td>
<td></td>
</tr>
<tr>
<td>The indicator should aim toward increasing customer satisfaction (instead of focusing on decreasing dissatisfaction). For example, the number of infections is a negative indicator. A positive indicator would be the scores on patient pain relief.</td>
<td></td>
</tr>
<tr>
<td>3. The indicator should follow RUMBA guidelines:</td>
<td></td>
</tr>
<tr>
<td>Reasonable - relating to a critical process; worth measuring.</td>
<td></td>
</tr>
<tr>
<td>Understandable - clear and concise.</td>
<td></td>
</tr>
<tr>
<td>Measurable - can be represented numerically and tracked over time.</td>
<td></td>
</tr>
<tr>
<td>Believable - &quot;do-able&quot;; a goal that can actually be reached</td>
<td></td>
</tr>
<tr>
<td>Achievable - can help achieve quality improvement in the department.</td>
<td></td>
</tr>
</tbody>
</table>

4) Create Evaluation Structure for Quality Indicators

An Excel spreadsheet was created based on the final department list which lists the, the name of each department required to submit quality indicators, their corresponding division and accounting numbers of the department, the description
of quality indicators that have been submitted, and evaluation scores for each indicator. The evaluation scores are based on the following information:

- For each indicator, each of the seven criteria is rated on a scale of 0 to 2. A score of 0 means the indicator does not satisfy the criteria, 1 means it satisfies the criteria somewhat, and 2 means it completely satisfies the criteria.

- Because some criteria are or may become more important than others, we established a weighting system for the seven criteria. Currently, the Customer Focus criterion has a weight of 2, and the others have a weight of 1. These weights can be easily changed on the spreadsheet if necessary.

- We defined the weighted score based on the criteria as the sum of each criteria score multiplied by its appropriate weight. The total possible points for this weighted score is currently 14.

- We also added another type of score, which relates to the status of the data. This score reflects whether each indicator currently has data available (2 points), if the data is being monitored graphically (4 points), and whether that information has been submitted to the appropriate source (the Corporate Lead Team or your office) (6 points).

- A total score for each indicator is defined as the sum of the weighted score based on the 7 criteria, and the score based on the monitoring status. The total possible points for this score is 20.

An example format of this evaluation structure is included in Appendix A.

5) Evaluate Quality Indicators

The updated list of quality indicators and their evaluations consists of 144 indicators. The project team evaluated each indicator, comments were made regarding how the indicators might be improved. This information was not sent directly to the departments, but is available for use in the future. It has not yet been decided how to best utilize this information.

Although the spreadsheet will not be complete until all indicators are developed and put in place, the framework exists for including them when they are available. The most current list of these indicators is available in the Log of Quality Indicators: Quality Indicator Tabular and Graphical Data. This spreadsheet is available on a computer disk.

6) Prepare Notebook of Quality Indicators

In addition to providing a list of indicators and their evaluations, we have prepared a notebook which will contain the data, in both tabular and graphical form, of all current indicators. Our original goal was to have this notebook complete by the end of the project. However, its completion depends primarily on the departments submitting the required information. Not many departments have submitted data, so we have prepared the shell for this notebook, to be completed when more information is obtained.
7) Create Example Reporting Structure for Data

In order to make it easier for departments to tabularly and graphically submit their data, we have created a sample blank spreadsheet for their use. The spreadsheet contains a specified area for inputting data. In addition, it includes a tabular reporting format which is directly connected to a graphical format. Both formats can easily be printed.

This spreadsheet is available on Excel for Macintosh (versions 3.0 and 4.0), Excel for DOS (versions 2.2 and 4.0), and Lotus 1-2-3, wks file type. It will be made available to the departments, along with directions for its use through our client's office. Example tabular and graphical reports, and the instructions, are included in Appendix C.

8) Research Future Automation Alternatives

The future success of a quality indicator performance monitoring system rests with the ability to accurately store and report quality indicator data. While much of this project focused on establishing the framework for collecting information about the progress of establishing quality indicators within the departments, it was also aimed at gathering information about possibilities of creating a computerized reporting mechanism. The project team took the following steps in researching this topic.

• Met with Joyce Miller of the Quality Assurance department regarding their monitoring software.

• Spoke to John Ellison of the Information Networking Systems department about mainframe software availability and graphing capability, and other options for recording the data.

• Met with Joan McCollum and Roger Wilfong of the Information Networking Systems department regarding access to the Banyan network and possible ways to incorporate the local area network into a reporting mechanism.

• Discussed various alternatives to developing a reporting mechanism, based on the usefulness to the departments. Issues relating to report frequency, centralized vs. decentralized reporting, and computer program architecture were addressed.

9) Develop and Report Recommendations

The results of our research and project work was combined into a final report. Our findings and recommendations follow.

Findings and Conclusions

Quality Indicator Development

Based on the fact that some departments are still in the process of developing and refining quality indicators, not all the data are currently available. Because of the large number of departments expected to submit indicators, it is often difficult to accurately communicate
to them and follow-up with them. Although the structure is now in place to record the
information, it is important for the departments to understand the requirements of
reporting quality data, and how to monitor it. We found that not all departments are
aware of the significance of establishing quality indicators, and feel it is important to
focus on increasing communication and awareness on the subject.

Reporting Mechanism

The project team evaluated each of the three methods of storage and retrieval of
departmental quality indicator measurements listed in the Current Situations section of
this report. Each method and its advantages and disadvantages are listed below:

Method 1 (Decentralized)

Advantages:  
• A spreadsheet used on each different type of PC would make it
  very easy to enter data and generate graphs.
• A macro on the spreadsheet could ensure consistent graphical and
  tabular displays of data.
• The responsibility for entering and tracking the data would lie with
  the individual departments.

Disadvantages:  
• The disparity among the types of personal computers and versions
  of software available in each department makes it nearly
  impossible to design a macro for each type of system.
• The use of this method would also keep all of the information
  decentralized (in each department), making it difficult for
  management personnel to review the data from different
  departments.

Method 2 (Centralized)

Advantages:  
• All of the data would be centralized and available to anyone who
  may need to access it.
• The data would be processed centrally, facilitating consistent
  reports.
• Nearly every department has some means of accessing the
  mainframe.

Disadvantages:  
• Centralization of data and data processing takes the responsibility
  away from the individual departments.
• The mainframe is a transactional driven system. It is not intended
  to run applications for tracking quality indicator measurements.
• There is no facility on the mainframe for creating graphical
  displays of data.
• May add a level of bureaucracy, and substantial delay in
  completing reports.

Method 3 (Combination Centralized/Decentralized)

Advantages:  
• The responsibility for tracking and entering the data would lie with
  the individual departments.
• The data would be processed at each department and the tabular information would be centralized (accessible from the network and/or mainframe).
• Each department could create consistent graphs by following the example graphical reporting structure.

Disadvantages:
• Management must ensure that the departments follow a standard form for reporting the data.
• It must be ensured that the data reported in the tabular and graphical form is the same as the data put in a central location.
• Not every department is connected to the Banyan network.

Recommendations

Quality Indicator Development

To continue the quality improvement effort, our team suggests that a person be assigned to be in charge of following up with the departments and updating the quality indicator information. This would include updating the notebook and the evaluation spreadsheet, as well as preparing reports to indicate which departments have or have not been submitting or monitoring quality data. This person might also provide feedback to the departments, including making use of the evaluation scores that are in place.

Not only is it important to maintain communication with the departments regarding this effort, but it is also necessary to have strong support from management. At the current level of support, this project may not have enough strength to continue. The departments must see the importance of monitoring quality indicators through examples set by management.

Reporting Mechanism

One very important aspect of implementing a quality indicator measurement tracking mechanism is the need to have all of the tabular data from each department available to management. Method 2 accommodates this aspect, but at the expense of relieving the departments of the responsibility of processing and monitoring their own data. It is important for each department to be able to graph its own data so that trends within that department are clearly evident and can be acted upon. Method 3 allows each department to graph its own data and allows management to easily review all of the tabular information in a central location.

It is necessary to construct consistent tabular and graphical displays of data so that management can easily interpret the information from each department. Method 3 allows each department to format their data to create consistent, yet tailored, reports. By following the examples of tabular and graphical displays of data, the departments will be able to generate consistent reports that can be easily reviewed by management.

There are a few problems associated with using the mainframe as means of centrally locating the data. First, the amount of information that needs to be accessed is not large enough to warrant allocation of file space on the mainframe. Secondly, the mainframe is largely a transactional driven system and is not intended for storage of raw data files. The structure of the mainframe system does not facilitate the use of individual accounts to access stored data.
The project team has researched the use of a shared file on a Banyan file server as a repository for Quality Indicator Measurement data. A discussion of the Banyan file servers and the implementation of a shared file follows. In the discussion, workstation is a generic term referring to either a Macintosh or a PC.

Banyan File Servers

There are currently 41 file servers attached to the Banyan network. These 41 file servers are directly attached to 30 departments (see Appendix C). In order for workstations to be connected to a Banyan file server, the file server must be on a token ring (method of networking workstations) and must have Vines 5.0 (networking software used with Banyan networks) installed. INS is presently moving all of the Banyan file servers onto token rings and upgrading them with Vines 5.0 networking software. When this is accomplished, workstations on the Banyan network and other networks will be permitted to access the Banyan file servers in their own department and other departments attached to the Banyan network.

Outside of the 30 departments directly attached to Banyan file servers, other workstations in other departments can still access a Banyan file server if that department is on the Banyan network or a network that is attached to the Banyan network. A workstation within a department meeting these requirements is said to have access to a Banyan file server. An example of this would be the Internal Medicine department. Internal Medicine is on a local network that is connected to a Health Sciences Network, which in turn is connected to the Banyan network. The workstations on the local net in Internal Medicine can still access any Banyan server.

Shared File Implementation

Creation and Access:
A shared file is a file that is accessible by many different workstations over a network. Permission to access the shared file is determined by administration and enforced by access lists. The creation of a shared file on the Banyan file servers is a minimal task. It requires but a few minutes for an INS system administrator to set up the file. Access privileges to the shared file are just as easily resolved. To define access privileges, a list of people who are allowed to access certain files is needed by INS. To access a Banyan file server, one would simply log on using a Macintosh or PC and select the correct server. From a PC, a user would execute the BAN.COM file to open a connection to a Banyan server. From a Macintosh, a user would open the chooser and click on the Banyan server icon.

Format of Shared File:
A standard format for storing the data should be established. The Banyan file servers are PC compatible computers that can run DOS applications. Almost every PC or Macintosh throughout the departments can run either DOS Lotus 1-2-3, DOS Microsoft Excel, or Macintosh Microsoft Excel. All of these applications can read in (import) text files. These software applications can also write (export) text files. If the shared file on the file server were a text file, workstations could read and write the files on the server without any problems.
Limitations of the Banyan Network

- The Banyan file servers must be running Vines 5.0 and be networked via a token ring in order for workstations to access a shared file.

- Not every department has a file server. It would be easy to set up a separate shared file for a department that does not have a file server on the file server of another department. However, this may cause a cost allocation problem as a result of one department using another department's disk space and file server.

- It is difficult to determine the exact number and location of workstations that can connect to Banyan. Workstations are connected to networks that are connected to Banyan, and are not counted as workstations with direct access to Banyan. Workstations are added to the Banyan network without being accounted for in an overall list. The most effective way to determine which departments are connected to the Banyan network is through direct communication with each department.

- There are costs associated with connecting workstations to the LAN (Local Area Network). There is an internal price listing for making these connections. INS can provide LAN connection for about $750 per workstation. Any of the stand alone Appletalk networks (network of Macintosh computers) would have to be connected to a Banyan token ring. To connect an Appletalk network, the Appletalk network routing change would cost about $900 and the installation of a local talk card would cost about $350.

For the above reasons, the project team believes that there should be a system in which a shared file is located on a server on the Banyan network system that is accessible by the appropriate people. This would provide a sufficient means for monitoring, reporting, storing, graphing, and retrieving data.

Action Plan

Quality Indicator Development

Based on our recommendations, we propose that the following steps be taken in order to continue the Total Quality Management project:

- Continue requesting data from the departments and updating the appropriate information in the notebook and evaluation structure.

- Communicate to the departments:
  - The importance of establishing quality indicators.
  - The requirement that each department submit the descriptions of two quality indicators, along with monthly data in both tabular and graphical form.
  - The evaluations for the current indicators.
  - The availability of example reporting formats.
  - The support by upper management.

- Prepare monthly reports indicating which departments have or have not submitted quality indicators.
Reporting Mechanism

In order to establish a reporting mechanism utilizing a shared file on the Banyan network, we propose the following actions:

• Establish a connection between each department and a Banyan file server.
  
  A department would need to either have its own file server (capital investment of $6,000 to $20,000) or use file space on another department's file server.

• Each department should create a shared file on a Banyan file server (an INS administrator will do this).

• Provide INS with the names of personnel who should have access privileges to each shared file. INS will create access permission lists for each shared file.

• Agree upon a standard format for saving tabular data (most likely a text file) and communicate this to the departments.
## Appendix A

### Weights for Criteria for Indicators:

<table>
<thead>
<tr>
<th>Positive</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Focused</td>
<td>2</td>
</tr>
<tr>
<td>Reasonable</td>
<td>1</td>
</tr>
<tr>
<td>Understandable</td>
<td>1</td>
</tr>
<tr>
<td>Measurable</td>
<td>1</td>
</tr>
<tr>
<td>Believable</td>
<td>1</td>
</tr>
<tr>
<td>Achievable</td>
<td>1</td>
</tr>
</tbody>
</table>

Each of the seven criteria may be given a score of 0, 1, or 2, where:
- 0 = Does not satisfy criteria
- 1 = Satisfies criteria somewhat
- 2 = Completely satisfies criteria

Best Possible Score for Weighted Total: 16

### Weighted Total

The Weighted Total is the sum of the scores for each criteria multiplied by its appropriate weight.

### Data Status Score

The Data Status Score is the score based on the monitoring status, as described above.

### Total Score

The Total Score is the sum of the Weighted Score and the Data Status Score

### Scores for QIs based on Criteria

<table>
<thead>
<tr>
<th>Department Name</th>
<th>No. Indicator</th>
<th>Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>A/D PROFESSIONAL SVCS</td>
<td>1</td>
<td>Supply Distribution Function. Fill rates - the % of line items and orders completely filled. Turnaround times - the median turnaround time for <em>stat</em> and routine delivery of supplies. Top 3 customers contacting the Material Service Center.</td>
</tr>
<tr>
<td>MATERIEL SERVICES</td>
<td>2</td>
<td>Patient Equipment Function. Response time for patient equipment deliveries.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Department Name</th>
<th>No. Indicator</th>
<th>Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>MATERIEL SERVICES</td>
<td>2</td>
<td>Patient Equipment Function. Response time for patient equipment deliveries.</td>
</tr>
<tr>
<td>GEN &amp; ADMIN-OPERATIONS</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Each indicator is also given a score to reflect its status of being measured and monitored, where:
- 0 = Not currently being measured/monitored
- 2 = Data is being collected
- 4 = Data is being graphed; trend chart available
- 6 = Data and trend chart submitted to CLT or Assoc. Director's Office

**WEIGHTED TOTAL**

The Weighted Total is the sum of the scores for each criteria multiplied by its appropriate weight.

**DATA STATUS SCORE**

The Data Status Score is the score based on the monitoring status, as described above.

**TOTAL SCORE**

The Total Score is the sum of the Weighted Score and the Data Status Score
Appendix B

Instructions for Reporting Quality Indicators (using Macintosh Excel)

The enclosed disk includes a blank format to use for entering data for your quality indicators. Once you enter the data, you can easily print out a copy of it in tabular form, as well as graphically.

This instruction sheet assumes basic knowledge of the software application (Excel or Lotus).

In the following instructions, substitute <ver> with the appropriate extension listed in the table of file formats below.

Examples of each are included on this disk. To view the tabular form, open the file EXTAB<ver>. While this file is still open, choose the command "OPEN" under the File menu, and open the file EXGRPH<ver>.

Instructions for entering and updating your own data are as follows:

Entering Data for the First Time:

Make sure you have the appropriate software application. This could be either Microsoft Excel for the Macintosh, Microsoft Excel for DOS, or Lotus for DOS. The following list of file formats are included on 3.5" floppy disks packaged with the Log of Departmental Quality Indicators: Quality Indicators Tabular and Graphical Data.

Macintosh Format:

<table>
<thead>
<tr>
<th>File Name</th>
<th>Software Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXTAB.3.0</td>
<td>Microsoft Excel ver 3.0</td>
</tr>
<tr>
<td>EXGRPH.3.0</td>
<td>Microsoft Excel ver 3.0</td>
</tr>
<tr>
<td>IND1TAB.3.0</td>
<td>Microsoft Excel ver 3.0</td>
</tr>
<tr>
<td>IND1GRPH.3.0</td>
<td>Microsoft Excel ver 3.0</td>
</tr>
<tr>
<td>EXTAB.4.0</td>
<td>Microsoft Excel ver 4.0</td>
</tr>
<tr>
<td>EXGRPH.4.0</td>
<td>Microsoft Excel ver 4.0</td>
</tr>
<tr>
<td>IND1TAB.4.0</td>
<td>Microsoft Excel ver 4.0</td>
</tr>
<tr>
<td>IND1GRPH.4.0</td>
<td>Microsoft Excel ver 4.0</td>
</tr>
</tbody>
</table>

DOS Format:

<table>
<thead>
<tr>
<th>File Name</th>
<th>Software Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXTAB.WKS</td>
<td>Lotus 1-2-3 (.wks file type)</td>
</tr>
<tr>
<td>IND1TAB.WKS</td>
<td>Lotus 1-2-3 (.wks file type)</td>
</tr>
<tr>
<td>EXTAB3.XLS</td>
<td>Microsoft Excel ver 3.0</td>
</tr>
<tr>
<td>EXGRH3.XLC</td>
<td>Microsoft Excel ver 3.0</td>
</tr>
<tr>
<td>IND1TAB3.XLS</td>
<td>Microsoft Excel ver 3.0</td>
</tr>
<tr>
<td>IND1GRH3.XLC</td>
<td>Microsoft Excel ver 3.0</td>
</tr>
</tbody>
</table>
1. Open the file "IND1TAB<ver>"
   - This file will be used to update all of your subsequent data for one of your indicators. (Use "IND2TAB<ver>" for data entry for the second indicator). If you want to keep a copy of this in its original form, make a copy of both "IND1TAB<ver>" and "IND1GRPH<ver>" before making any modifications to the files.
   - The spreadsheet already has some information on it, including the date and spaces for you to input information specific to your department.

2. In the cells next to each of the following titles, type in the appropriate information:
   - Major Department
   - Department
   - Account Number
   - Indicator (This should be a simple, one line title for the indicator)
   - Description (Additional space is provided for you to provide more detail on the indicator)
   - Target Value (You may enter a target value for the indicator if you prefer)
   - You may also add a short (10 character) title to your data. In Cell D18, replace "Data Value" with this title. This title will then appear on the graph.

This first page is linked to a document that will graph the data. The columns labeled Date and Data Value in cells C18 and D18 are used to print the tabular data, and to relate the appropriate information to a graph. It has been decided that 18 data points are sufficient for each reporting period. Therefore, only up to 18 data points will be printed on the tabular and graphical reports at a time.

Data entry will be made only in columns G and H (labeled Date and Input Data). Data should be entered chronologically (most recent data last) and the dates should be the same distance apart (preferably every two weeks or monthly).

3. For each data point, enter the date in column G and the appropriate number in column H.
   (NOTE: Column G is already formatted for dates, and column H is formatted for numbers. Feel free to format the number column to correspond to your data, if necessary).

4. When you enter up to 18 data points this way, the spreadsheet will automatically copy the information to the first page of the document (the one which is used for reporting). It will also report the average, maximum and minimum data values for the time interval.

5. When you are finished entering the data, choose "Print" under the File menu, and the tabular form will be printed.

6. Under the File menu, choose "Open" and open the file "IND1GRPH<ver>". A graph of the data you just inputted will appear.

7. You may customize the graph by adding text if you prefer, or add any other information you would like. Then, choose "Print" under the File menu to print the graph.
8. Before closing this document, be sure to update your changes by SAVING it. After you close this document, Save the "IND1TAB<ver>" as a text file as well. You can then QUIT out of the application.

Updating Data

1. When you have additional data to input, continue entering it in columns G and H, as before. Enter all data chronologically, adding to the data that was previously input. You will not write over any data, but will simply add to it. This way, you can keep a record of past data. Start inputting data in the rows directly beneath the previous data.

2. Once you have input all of your data, you must copy this new data into the appropriate section on the tabular reporting page. You may want to report the most recent 18 data points now, or you might want to report on a different set of data points. As long as the data you want to report is 18 successive points, this can be easily done.

3. Highlight the 18 data points in columns G and H that you want to report and graph. In most cases, this will be the last 18 data points in columns G and H.

4. Choose Copy from the Edit menu.

5. Highlight the cells in columns C and D which correspond to the tabular reporting form. (These are the bordered cells C18 to C36 and cells D18 to D36). All 38 cells should be highlighted at the same time.

6. Choose Paste from the Edit menu.

7. Your new numbers will now appear. Print this now.

8. Before closing this file, open the "IND1GRPH<ver>" document. Your new numbers should be graphed here as well. Print the graph.

9. Be sure to save each document before quitting the application.

10. Each time you have new numbers to add, just continue to add them underneath the data that is already there in columns G and H, and paste them into cells C18 to C36 and cells D18 to D36.
Reporting Form for Quality Indicator Measurements

Date: 12/17/92

Major Department:
Department:
Account Number:
Dept. Head/Manager:

Quality Indicator: Average wait times in minutes
Description: (if necessary)

Target Value: less than 10

<table>
<thead>
<tr>
<th>Data Point</th>
<th>Date</th>
<th>Wait Times</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1/21/91</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>2/21/91</td>
<td>9</td>
</tr>
<tr>
<td>3</td>
<td>3/21/91</td>
<td>7</td>
</tr>
<tr>
<td>4</td>
<td>4/21/91</td>
<td>14</td>
</tr>
<tr>
<td>5</td>
<td>5/21/91</td>
<td>8</td>
</tr>
<tr>
<td>6</td>
<td>6/21/91</td>
<td>12</td>
</tr>
<tr>
<td>7</td>
<td>7/21/91</td>
<td>15</td>
</tr>
<tr>
<td>8</td>
<td>8/21/91</td>
<td>6</td>
</tr>
<tr>
<td>9</td>
<td>9/21/91</td>
<td>8</td>
</tr>
<tr>
<td>10</td>
<td>10/21/91</td>
<td>11</td>
</tr>
<tr>
<td>11</td>
<td>11/21/91</td>
<td>13</td>
</tr>
<tr>
<td>12</td>
<td>12/21/91</td>
<td>8</td>
</tr>
<tr>
<td>13</td>
<td>1/21/92</td>
<td>7</td>
</tr>
<tr>
<td>14</td>
<td>2/21/92</td>
<td>9</td>
</tr>
<tr>
<td>15</td>
<td>3/21/92</td>
<td>14</td>
</tr>
<tr>
<td>16</td>
<td>4/21/92</td>
<td>9</td>
</tr>
<tr>
<td>17</td>
<td>5/21/92</td>
<td>9</td>
</tr>
<tr>
<td>18</td>
<td>6/21/92</td>
<td>12</td>
</tr>
</tbody>
</table>

Interval Avg: 9.78
Interval Max: 15
Interval Min: 5
## Information and Networking Services
### Departments on the U of M Medical Center’s Banyan Network

1. **Administration**  
   Office of the Executive Director  
   (Executive Suite)  
   (Executive Suite)

2. **Ambulatory Care Services**  
   - M-Care Health Center - Northeast  
     (NE Ann Arbor)  
   - M-Care Health Center - Northville  
     (Northville)  
   - M-Care Health Center - Plymouth  
     (Plymouth)  
   - Nutrition Counseling Center  
     (Nutrition Svcs)  
   - U of M Medical Group, Briarwood Campus  
     (NetSvcs)

3. **Attorney**  
   (Executive Suite)

4. **Biomedical Communications**  
   (Wolverine5)

5. **Biomedical Engineering**  
   (PlantSupport)  
   (Wolverine5)

6. **Bone Marrow Transplant Program**  
   Bone Marrow Transplant Clinic  
   (Mott Cancer Cen)  
   (Mott Cancer Cen)

7. **Facilities**  
   - Administration  
     (FacAdmin1)  
   - Capital Budget Program  
     (FacAdmin1)  
   - Design and Construction  
     (Wolverine1)  
   - Environmental Health & Safety  
     (Wolverine3)  
   - Facility Engineering  
     (FacAdmin1)  
   - Infection Control  
     (FacAdmin1)  
   - Maintenance  
     (PlantSupport)  
     (Wolverine5)  
   - Planning and Design  
     (FacAdmin1)  
     (PlantSupport)  
     (Wolverine5)  
   - Project Support  
     (FacAdmin1)  
     (PlantSupport)  
     (Wolverine5)

8. **Finance**  
   - Administration  
     (NIB Finance)  
   - Billing and Third Party Collections  
     (NIB Finance)  
   - Financial Information Services  
     (NIB Finance)

9. **Food and Nutrition Services**  
   - Administration  
     (Nutrition Svcs)  
   - Food Procurement  
     (Nutrition Svcs)  
   - Non-Patient Food Services  
     (Nutrition Svcs)  
   - Nutrition Services  
     (Nutrition Svcs)  
   - Patient Food & Nutrition Services  
     (Nutrition Svcs)

10. **Gift Shops** (FRIENDS of University Hospital)  
    (Executive Suite)

11. **Housekeeping Services**  
    (Wolverine2)
12. I.D./Key Office

13. Information Services Division
   Information & Networking Services
   Information Center
   Medical Information Services

14. Internal Medicine
   Brighton Health Center

15. Learning Resource Center

16. Management Systems

17. Materiel Management
   Materiel Management Information Systems
   UARCO

18. M-Line

19. Nursing Services
   Educational Services
   Nursing Scheduling
   P/P/P Nursing Administration
   UH & Kellogg Nursing Administration

20. Obstetrics and Gynecology
   Administration
   Labor & Delivery

21. Office of Clinical Affairs

22. Ophthalmology

23. Otolaryngology
   Administration
   Pediatric Otolaryngology Administration
   Vestibular Testing Lab

24. Patient-Staff Relations (Risk Management)

25. Pediatrics
   Newborn Services
   Pediatric Cardiology
   Pulmonary Services

(Wolverine4)
(Executive Suite)
(HIS Department)
(INS Banyan-Mac)
(LAN Development)
(Medical Info)
(Brighton1)
(Student Carrel)
(Executive Suite)
(Mat Mgmt Dept)
(Mat Mgmt MIB)
(Mat Mgmt MIB)
(NIB Marketing)
(Nursing Ed NIB)
(HIS Development)
(MCHC Nursing)
(MIB Nursing)
(MCHC Nursing)
(MIB Nursing)
(OB GYN MPB)
(Fetal Monitor)
(MIB OCA)
(KEC Ophthy)
(MIB OTO)
(MIB OTO)
(MIB OTO)
(Executive Suite)
(MIB OCA)
(Newborn Svcs)
(Peds Cardiology)
(Newborn Svcs)
### 26. Physical Medicine & Rehabilitation
- Electromyography
  - MedRehab
- Occupational Rehabilitation & Health
- Orthotics and Prosthetics
- Rehabilitation Engineering
- Spinal Cord Injury Center
- Wheelchair Seating Service

### 27. Planning and Marketing
- Referring Physician Communications
- Referring Physician Computer Network
- Research and Planning

### 28. Security Services

### 29. Inpatient Operations

```
f:\micro\h170\depts.wp
i:\lan_docs\tomforms\dept.wp
```

<table>
<thead>
<tr>
<th>Original Date</th>
<th>Amended Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>09/16/91</td>
<td>01/20/92</td>
</tr>
<tr>
<td>11/16/92</td>
<td></td>
</tr>
</tbody>
</table>

### 30. Pharmacy

```
online March 93
```
QUALITY INDICATORS PROJECT

Interim Report

Peter Giordano
Patrick Herzog
Christina Tatting

November 9, 1992
Introduction

The Quality Indicators project focuses on gathering and evaluating quality indicators submitted by the departments at the University of Michigan Hospitals, and establishing a reporting mechanism for monitoring their performance.

Purpose

Based on the progress up to this point, our purpose remains to develop a framework for the departments at the University of Michigan Hospitals to consistently track and report their progress based on customer focused quality indicators.

Status

The following steps have been completed:

1) Developed a complete list of departments within the hospital that should submit quality indicators. This list is organized around eleven major departments, based on the accounting structure at the hospitals. It will be used to track which departments have submitted indicators and which departments are measuring their performance.

2) Developed a list of criteria for evaluating the indicators. This includes developing operational definitions for the criteria. We submitted this list to the client for final approval. The final list is included in Appendix A.

3) Drafted a memo to the departments (through our client’s office) which introduced our group and the project. The memo requested that the departments submit any new or updated indicators. We also included the list of criteria so that they could better understand the evaluation process and use it as a guideline for updating their indicators. Included with this memo was a copy of the most recent list of indicators that has been submitted.

4) Developed an evaluation structure for the indicators, based on the seven criteria developed. The structure is an Excel spreadsheet which shows the department, their quality indicators, and their evaluation scores. The scores represented are a weighted value based upon the seven key issues of evaluation. At the present time, each of the seven criteria has a weight of one.

5) Updated the log of indicators based on the original submitted forms. During the evaluation process, we found that some of the indicators from the original forms were not included on the initial log of quality indicators. This log entailed a preliminary list of 64 departments which had previously submitted their indicators to our client at the onset of the project. We added the appropriate indicators to the log of indicators.
6) Evaluated the updated log of quality indicators, which consists of 144 indicators. We also made comments regarding how the indicators might be improved. Once evaluated, the log was sent to our client for review and for further modifications of the indicators that did not fully meet all of the criteria.

7) Spoke to Joyce Miller of the Quality Assurance department regarding their monitoring software. Spoke to Information Networking Systems about mainframe software availability and graphing capability.

8) Discussed various alternatives to developing a reporting mechanism, based on the usefulness to the departments (see Problems and Issues #1).

9) Created an example reporting structure on Excel.

Problems and Issues
(to be addressed at the Interim Meeting with the client, scheduled November 11).

1) Decentralization or Centralization of Data

We have defined two possibilities for collecting the data from the departments, and noted advantages and disadvantages of both ways.

The first is decentralization. Each department would enter their own data into a spreadsheet, and produce a graphical representation of it. The report would be submitted to our client's office. This method is advantageous because the departments are responsible for measuring and monitoring their own data. However, because there are various software packages being used by the different departments, it may be difficult to ensure that each department can use the software that the reporting mechanism is built on. It is possible to make the spreadsheet available on several versions of Excel and Lotus, but without knowing how many different packages are being used, it may be difficult to accommodate every department. Another alternative is to let the departments use whatever graphing software they are currently using. Our reporting mechanism would be made available to those departments that are not currently graphing their progress. The departments would be responsible for obtaining the necessary software. The disadvantage is that the graphics may not be consistent between departments (see #2).

Centralization of the data is the second possibility. The departments would send the data to a central location, where it would be input to the mainframe. This would make all data available to anyone who might need it. However, graphing capabilities are minimal on the mainframe. In addition, the departments would be further removed from their data.
2) **Consistency of Reporting**

Some of the departments are already monitoring and graphing their quality indicators. They are using different formats (i.e., bar charts, pie charts, scatter plots) as well as different software (Lotus, Excel, etc.). It was originally decided that a consistent format should be used. However, we should consider the impact of asking some of the departments to change the format they have already established.

In addition, our original intention was to gather what data is available, and create a notebook for it. Because some data has already been submitted in tabular and graphical form, it would take considerable time to convert it all into one consistent format. We need to decide on a final format for reporting.

3) **Gathering Data**

As stated in the proposal, we need to gather data in order to put together a notebook of quality indicators. Although the departments have been asked to submit their indicators, not all of them sent in the actual data. The original log of indicators (dated September 1991) contained some indicators for which data was not available. That data might be available now. Therefore, we should establish how to gather the data, and in what specific format (if any).

4) **Graphical Display of Data**

A clear definition of the format of the graphic representation of the data is required. It has been suggested that the monitoring system should chart some quantitative value over time. An example would be the number of records processed per day over a month's time period.

The frequency (i.e. monthly, quarterly, bimonthly) with which the data should be entered has to be determined. Can it differ between departments? Should there be a standard sample size of dates to enter? Should each graph for each department display data over the same time frame?

A method for testing the graphical data has to be determined. Should the graphs be control charts, or should departments chart their progress against target values?
Plan For The End Of the Semester

1. Meet with client
2. Evaluate the new indicators
3. Gather the available data from the departments
4. Finalize the reporting mechanism and prepare a user manual for it
5. Finalize the notebook
6. Prepare a draft of the final report
7. Complete the final report
8. Final presentation

Work Plan

1. Meet with client on November 11 to discuss the following:
   - The methods needed to resolve the current problems and issues as discussed above.
   - Interim report

2. Evaluate the new indicators which are received before the deadline of November 14. Submit these new evaluations and suggestions to client.

3. Gather the available data from the departments in the current log of indicators.
   - Contact those departments which were monitoring their indicators
   - Obtain data through our client in tabular and graphical form

4. Finalize the reporting mechanism and prepare a user manual for it.

Reporting mechanism
- Supply software systems to those departments needing a system
- Supply user manual available for software systems used (Excel and Lotus versions)
5. **Finalize the notebook of quality indicators to be submitted at final presentation.**
   Includes the following:
   - Departmental names and structure based upon the accounting structure
   - At least two indicators and their measurements
   - Tabular representation of data (when available)
   - Graphical representation of the tabulated data (where applicable)

6. **Prepare a draft of the final report**
   - Submit draft to client for review and modifications

7. **Complete the final report**
   - Review and modify any changes from draft

8. **Final presentation to be done**
   - For client on December 11
   - For class on December 16